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About this manual1.

Copyrights1.1.

The information in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental, or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to a third party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2006 ABB. All rights reserved.

Trademarks1.2.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General1.3.

This manual provides thorough information on Station Automation COM600 (later
referred to as COM600) and the central concepts related to it. The manual provides
information about COM600 features, installation and unistallation instructions for the
Station Automation Builder 600 (SAB600), and configuration and operation instructions
for SAB600. For more information on each topic related to a specific protocol, refer to
the list of related documents in 1.8, Related documents.

Document conventions1.4.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.

5

COM600 3.3Station Automation COM6001MRS756125

User's Manual



• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.
For example, press the ENTER key.

• Lowercase letters are used for the name of a keyboard key that is not labeled on the
keyboard. For example, the space bar, comma key, and so on.

• Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

• Press ESC E C indicates that you press and release each key in sequence (to copy
a selected object in this case).

• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.

• The following convention is used for menu operations: MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30 .

• You can be asked to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name

Use of symbols1.5.

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.

The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.
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The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

Terminology1.6.

The following is a list of terms associated with COM600 that you should be familiar
with. The list contains terms that are unique to ABB or have a usage or definition that
is different from standard industry usage.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

An OPC service for providing information about process data to
OPC clients.

Data Access; DA

Part of a logical node object representing specific information,
for example, status, or measurement. From an object-oriented
point of view, a data object is an instance of a class data object.
DOs are normally used as transaction objects; that is, they are
data structures.

Data Object; DO

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set

A physical device that behaves as its own communication node
in the network, for example, protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality, and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device; LD

The smallest part of a function that exchanges data. An LN is
an object defined by its data and methods.

Logical Node; LN

A communication protocol developed by Echelon.LON

A proprietary method of ABB on top of the standard LON pro-
tocol.

LON Application Guideline for
substation automation; LAG
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DescriptionTerm

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality, and Time Stamp.

OPC item

Named data item.Property

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

Report Control Block

ABB proprietary communication protocol used in substation
automation.

SPA

Protection and/or Control Product supporting the SPA protocol
version 2.5 or earlier.

SPA device

XML-based description language for configurations of electrical
substation IEDs. Defined in IEC 61850 standard.

Substation Configuration Lan-
guage; SCL

Abbreviations1.7.

The following is a list of abbreviations associated with COM600 that you should be
familiar with. See also 1.6, Terminology.

DescriptionAbbreviation

Alarms and EventsAE

Application Service Data UnitASDU

Buffered Report Control BlockBRCB

Data AccessDA

Data Message Code DefinitionDMCD

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Human Machine InterfaceHMI

International Electrotechnical CommissionIEC

Intelligent Electronic DeviceIED

LON Application Guideline for substation automationLAG

Local Area NetworkLAN

Logical DeviceLD
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DescriptionAbbreviation

LonMark interoperable device communicating in LonWorks network. In
this document, the term is used for devices that do not support the ABB
LON/LAG communication.

LMK

Logical NodeLN

LON SPA GatewayLSG

Network Control CenterNCC

Network VariableNV

Object Linking and EmbeddingOLE

OLE for Process ControlOPC

Protection & ControlP&C

Request To SendRTS

Substation AutomationSA

Station Automation Builder 600SAB600

Substation Configuration LanguageSCL

Single Line DiagramSLD

Simple Network Time ProtocolSNTP

Simple Object Access ProtocolSOAP

Report Control BlockRCB

Unbuffered Report Control BlockURCB

eXtended Markup LanguageXML

Related documents1.8.

MRS numberName of the manual

1MRS756125COM600 User’s Manual

1MRS756705COM600 Operator's Manual

1MRS756740COM600 HMI Configuration Manual

1MRS756739COM600 Data Historian Operator's Manual

1MRS756566DNP LAN/WAN Master (OPC)

1MRS756567DNP Serial Master (OPC)

1MRS755496DNP LAN/WAN Slave (OPC)

1MRS755495DNP Serial Slave (OPC)

1MRS755564External OPC Client Access

1MRS755382IEC 60870-5-101 Slave (OPC)
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MRS numberName of the manual

1MRS756703IEC 60870-5-101 Master (OPC)

1MRS752278IEC 60870-5-103 Master (OPC)

1MRS755384IEC 60870-5-104 Slave (OPC)

1MRS756704IEC 60870-5-104 Master (OPC)

1MRS755321IEC 61850 Master (OPC)

1MRS756738Logic Processor User's Manual

1MRS755284LON-LAG Master (OPC)

1MRS756569MNS iS Connectivity (OPC)

1MRS756126Modbus Serial Master (OPC)

1MRS756445Modbus TCP Master (OPC)

1MRS752275SPA Master (OPC)

1MRS755497SPA Router (OPC)

Document revisions1.9.

HistoryProduct revisionDocument version/date

Document created3.0A/16.10.2006

Document revised3.0B/22.1.2007

Document revised3.0C/8.6.2007

Document revised3.1D/21.12.2007

Document revised3.2E/17.6.2008

Document revised3.3F/13.2.1009
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Introduction2.

Overview of COM6002.1.

COM600 provides gateway functions for mapping signals between protection and control
IEDs in industrial or utility substations and higher-level systems. It further includes an
optional HMI that provides data and information from the substation to the users.

COM600 gathers data from protection and control IEDs and from process devices using
different communication protocols. The supported protocols can be combined freely in
one station computer, limited only by the number of hardware interfaces and the license.
COM600 uses web technology to display data to different users in a professional and
user-friendly manner. The web technology is further used to transfer information to a
network control centre (NCC) or distributed control system (DCS).

COM600 benefits from the potential of the IEC 61850 standard by using the IEC 61850-
6 substation configuration language (SCL) and IEC 61850 -7 communications modeling
regardless of protocol used. As the IEC 61850 data modeling is used for all communic-
ation protocols the gateway cross-reference is done in the same way regardless of the
protocol, for example IEC 61850-8-1 or DNP3.

COM600 can by using the optional web HMI (requires Microsoft Internet Explorer with
Adobe SVG viewer 3.03) be used for efficient substation visualization, monitoring and
control. Measured values from process devices are displayed on the HMI. Single-line
diagrams can be used to view any available measured values from the process devices.
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Product ordering codes

COM600_product_codes.jpg

Figure 2.1-1 COM600 product ordering codes

12

1MRS756125Station Automation COM600COM600 3.3

User's Manual



Features3.

Gateway functionality3.1.

The Gateway functionality provides a framework that enables the use of OPC server and
client components, such as OPC Client for IEC 60870-5-101 and OPC Server for LON
LAG 1.4. This manual presents the principles that are common to the protocols available
at the moment as well as to those that will be applicable in the future. For protocol-specific
information , refer to the respective client and server user’s manuals.

COM600Inside.bmp

Figure 3.1-1 Conceptual view of COM600 Gateway

1. Network Control Center (NCC)
2. Engineering PC with Station Automation Builder 600 (SAB600)
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3. COM600 with embedded operation system, OPC client(s) for NCC connection(s),
OPC server(s) for process connection

4. Protection and control devices

Normally, there is one OPC client per NCC connection. If you want to create several
NCC connections with the same protocol, use multiple instances.

COM600 consists of OPC Data Access (DA) server and client components. OPC Servers
are used mainly for master/client protocol stacks to provide access to the data in the
devices in the protocol. OPC Clients are used for slave/server protocol stacks to enable
external systems to access data available in the OPC Servers.

GWComponents.jpg

Figure 3.1-2 Example of COM600 Gateway components

HMI3.2.

HMI functions3.2.1.

The HMI enables the user to access the COM600 computer via a web browser.

The features of HMI include:
• Single Line Diagram
• Busbar coloring
• Event lists
• Alarm lists
• Parameter settings
• Disturbance data upload
• System supervision
• Breaker and switch control
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• Measurement display
• User management
• Data historian (optional feature)

sld_example.png

Figure 3.2.1-1 Example view of the COM600 HMI

The HMI can be accessed:

• locally via an optional local HMI screen
• locally by connecting your laptop to COM600 via LAN
• remotely through the internet or over LAN/WAN

Predefined user account3.2.2.

HMI has a predefined user account with administrator rights.

• User name: admin
• Password: adminadmin

When you log in for the first time as an administrator, change the password before you
proceed using HMI. If you forget the new password, restore the factory settings with the
Management tool in SAB600. After the factory settings have been restored, you can only
log in with the predefined administrator password mentioned above.
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OPC server3.3.

The OPC server component consists of a Master/Client Protocol Stack, OPC DA/AE
Server, and Configuration SCL.

The protocol stack component implements the protocol functions, such as handshaking
signal handling, message coding/decoding, check sum calculations, polling logic, protocol
level timers, and so on. The OPC server/protocol handler implements the functionality
for publishing and updating data on the OPC interfaces and protocol conversion between
the OPC and the protocol stack using the common IEC 61850 data model.

The configuration of the OPC server and the protocol stack is handled using a configur-
ation parser. The OPC server is configured using SAB600. The configuration information
is exported to an SCL/XML configuration file according to the IEC 61850 SCL specific-
ation. When the OPC server is started, the configuration information is read from the
file.

ServerConcept_a.bmp

Figure 3.3-1 Conceptual view of OPC server

OPC client3.4.

The OPC client software consists of a Slave/Server Protocol Stack, OPC DA Client,
Configuration SCL, OPC Data Access Server and Alarm&Event server components for
diagnostic and control.

The protocol stack component implements the protocol functions, such as handshaking
signal handling, message coding/decoding, check sum calculations, polling logic, protocol
level timers, and so on. The OPC client/protocol handler implements the functionality
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for data subscription from the OPC servers and protocol conversion between the OPC
and the protocol stack using the common IEC 61850 data model.

The configuration of the OPC client and the protocol stack is handled using a configura-
tion SCL. The OPC server is configured using SAB600. The configuration information
is exported to the SCL/XML configuration file according to the IEC 61850 SCL specific-
ation. When the OPC client is started the configuration information is read from the file.

ClientConcept_b.bmp

Figure 3.4-1 Conceptual view of OPC client

Logic Processor3.5.

COM600 offers an straightforward approach to the languages specified by the IEC 61131-
3 standard for programmable logic controllers (PLC). The programmable logic processor
in COM600 is offered as a selectable software option. The PLC programming system
enables programming and execution of automation tasks. In addition, the IEC 61131-3
programming in COM600 offers on-line and off-line functionality for engineering and
diagnostics.

The Logic Processor OPC Server transfers information between CodeSys SP runtime
and other COM600 components, such as OPC servers, slave clients, and Web HMI.
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Logic Processor.bmp

Figure 3.5-1 Functional overview of Logic Processor

CoDeSys SP runtime system is manufactured by 3S-Smart Software Solutions GmbH
(www.3s-software.com).

Data Historian3.6.

The COM600 data historian is a real-time database designed and optimized for process
information management and extensive history recording. The data historian is based
on ABB’s cpmPlus Knowledge Manager software. It combines the benefits of an easy-
to-use real-time database with industrial reliability, performance, and real-time function-
ality to provide an excellent platform for process information management.
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The data historian can be used for accurate process performance monitoring by following
process and equipment performance calculations with real-time and history values.
Better understanding of the process behaviour by joining time-based process measure-
ments with production and maintenance events helps the user to understand the process
dynamics. It further provides required information for learning how to keep the process
running. High performance and reliability, together with maintenance-free operation,
provide a solid platform for trending.

The optional data historian functionality offers means of storing, analyzing and
presenting process data.

IEC 61850 data modeling3.7.

To simplify protocol conversion and signal mapping in the gateway, each component
uses a common data model. The data model is based on common data classes and services
specified in the IEC 61850 standard. Each client and server component is a separate
program. The components interact with each other only via OPC interfaces. This means
that they can be developed and used independently as a part of the gateway as long as
they conform with the OPC DA and common data model specifications.

Protection and control products are connected to the gateway via OPC interfaces. Although
OPC provides means to access data on devices, it does not specify the semantics of the
data. This means that the same information is available in different formats depending
on which device and communication protocol is used. In addition, services, such as
breaker operation, vary among devices and protocols.

These differences complicate the reuse of gateway applications. To overcome this
problem, all the applicable data and services are remodeled in OPC servers according
to the data and service model specified in the IEC 61850 standard. This provides a pro-
tocol and device independent interface between the applications and the process. Fig-
ure 3.7-1 presents an overview of the IEC 61850 model usage.
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IECmodelling.jpg

Figure 3.7-1 Overview of IEC 61850 model usage

The smallest unit in the IEC 61850 modeling is a data attribute which is linked to an
OPC item in the OPC server. A data attribute can be, for instance, the state value of a
double point object (stVal), quality information (q), or timestamp (t). In the OPC server,
some of the services are also mapped to the same level as the attributes. This means that,
for example, control services (such as ctlOperOn, ctlOperOff) for operating a double
point object are available as OPC items.

For different types of data, the IEC 61850 standard defines over 30 common data classes
including a set of mandatory and optional attributes and services. For example, common
data classes are defined for Controllable double point (DPC), Single point status (SPS)
and Measured value (MV).

Furthermore, the standard defines approximately 90 functional groups of data, based on
common data classes. These groups are called logical nodes. Examples of logical nodes
are controllable switch (CSWI) and distance protection (PDIS).

Logical nodes can be further grouped under logical devices (LD), forming logical groups
within a physical device (IED), see Figure 3.7-2.
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LONNamespace.jpg

Figure 3.7-2 LON OPC Server name space in relation to IEC 61850 model

Station/Remote switch function3.8.

The COM600 gateway provides a common Station/Remote (S/R) switch functionality
for OPC servers and clients. The S/R switch is used to determine whether the objects in
a logical device of an IED can be controlled within the station, or remotely via a gateway.

A station can have one or more S/R switches. The switches are either physical switches
or software switches in a simulated IED of an OPC server. The S/R switches are modeled
using the IEC 61850 SPS, SPC, DPS, DPC, INS, or INC data class.

Each IED or logical device in an IED is linked with an S/R switch during the configuration
process. If a logical device has no linking information configured, the linking information
of the IED is used instead. At runtime, an OPC server publishes the logical device S/R
switch linking information for the OPC clients of the COM600 gateway. Each time an
OPC client sends a command to a device, it first checks the S/R switch position to
determine whether the operation is allowed or not. The COM600 gateway OPC client
is allowed to operate only if the S/R switch is in remote position.

A COM600 gateway OPC client has the operation modes disabled and enabled for S/R
switch handling. When the switch is in the enabled mode, the values for S/R switch
position failures are Allow controls if position unknown and Reject controls if position
unknown.

HMI is considered a local station HMI, if it uses the local display of the COM600 com-
puter, or if the IP address of the HMI client is in the range specified with a Station IP
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Address Filter property in the Gateway object. Otherwise HMI is considered a remote
HMI. The state of the station/remote switch controls whether the operations are allowed
from HMI or not.

The station/remote switch for the HMI is configured with the SLD editor by inserting
the Station Switch Indicator symbol to the substation SLD and specifying the data object
for the position information. If a real switch indication is not available, it is possible to
use a simulated data from a virtual IED. This can be done by creating an IED configuration
in the communication structure and setting the simulation mode of the IED to true.

COM600 Watchdog3.9.

The COM600 computer has a built-in hardware watchdog function. The function can be
enabled with SAB600 from the Gateway object properties. When enabled, the watchdog
monitors the COM600 software. If the COM600 software fails to send the keep-alive
triggering to the watchdog within a certain time, the watchdog restarts the COM600
computer.

External watchdog for COM6003.10.

COM600 can be configured to send periodically a command to an IED connected to
COM600. This function can be used to monitor the health of COM600. For example,
SACO 16D2 can be connected with SPA protocol to COM600 and configured to create
an alarm if no command from COM600 is received within specified time. Configuration
of an external watchdog device is described in 6.7, Configuring external watchdog for
COM600.

Network Fault Tolerance for COM6003.11.

COM600 can be configured to provide a certain level of tolerance against network failure
by using either the ABB DuoDriver feature or the Intel Teaming Feature, Switch Fault
Tolerance. These features are available when the optional dual port PCI Ethernet network
adapter is used.

DuoDriver

DuoDriver implements the Parallel Redundancy Protocol (PRP) for Ethernet as specified
in IEC 62439 DIS. PRP is based on duplicated networks, where each message is sent
via both networks, the receiver node accepts the first received message and discard the
duplicate. Message replication and discard function is done by the DuoDriver and it
hides the two networks from the upper level applications. In PRP there is practically no
switch over time in the case of one of the network fails as every message is always sent
to both networks. DuoDriver has diagnostic data, which can be read with IEC61850 OPC
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server. The diagnostic data can be further used on COM600 HMI and gateway applica-
tions. See 6.8, Installing and configuring Duo Driver for installation and configuration
details.

Switch Fault Tolerance

The Switch Fault Tolerance feature of the Intel network adapter requires the Teaming
Feature to be enabled.

Teaming Features include Failover protection, increased bandwidth through aggregation,
and balancing of traffic among team members. Teaming Modes are AFT, SFT, ALB,
RLB, and EtherChannel*/3ad (LA/FEC/GEC/3ad). Only Failover protection using SFT
is supported by ABB.

Queuing of Process Data Updates3.12.

This section describes the common queue mechanism for OPC Clients (slave protocols)
in COM600. There can be additional queuing mechanisms on different levels of the
protocol stacks, that are specific for the protocol, which are not described here.

Process data updates are queued in the OPC Clients of COM600. Each OPC Client has
its own queues independent from other clients, which prevents disturbances on one client
connection from interfering with other connections. There are four separate queues for
different type of data with configurable length.

• High Priority
• command replies/confirms
• internal protocol stack control commands
• protocol stack database initialization commands

• State Indications
• binary data and other state indications

• Measurements
• analog data

• Interrogated
• interrogation-related data and commands

Queue logic

For high priority and interrogated queues the oldest message is skipped when the queues
fill up. Generally these queues should never fill up since they contain a limited number
of updates (proportional to the number of OPC items).

When the state indication queue is full, the new updates are always skipped until there
is free space in the queue.
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When the measurement queue is full, an older update is always skipped when a new
update is pushed the queue.

The updates are skipped according to the following logic:
• If an item has two or more updates, the oldest update is skipped
• If no item has two or more updates, the oldest update in the queue is skipped.

For measurements, older updates for an item are also skipped when the queue reaches
a configurable percent of the maximum capacity (but only if there is an item with multiple
outstanding updates to send).

Queue priorities

If a high priority queue contains an update, it is always sent first. After that, the interrog-
ated queue is checked. If none of these queues has updates, the state indications and
measurements are checked in round-robin fashion.

Queue capacities

The capacity (maximum size) of each queue is independently configured. If one queue
fills up, capacity from another, possibly non-full queue is not used.
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Technical data4.

Mechanical properties4.1.

COM600_connectors.jpg

Figure 4.1-1 COM600 interfaces

The technical data of COM600 is presented in the following tables.

Table 4.1-1 Dimensions
ValueDescription

214 mm (243 mm with mounting kit)Width

122.4 mm (129.4 mm with mounting kit)Height

313 mmDepth

6.8 kgWeight

Table 4.1-2 Power supply
ValueDescription

110...220 V DC

100... 240 V AC (50...60 Hz)

Uaux nominal

80...120% of Un (88...264 V DC)

90...110% of Un (90...264 V AC)

Uaux variation

37 W (with 264 V DC)Power consumption

220 WPower consumption at start-up
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Table 4.1-3 Hardware
ValueDescription

Intel® Pentium M 1.6 GHzProcessor

1 GB SDRAMSystem memory

8 GB industrial SSDCompact flash memory

Table 4.1-4 Interfaces
ValueDescription

3 x RS-232 interfacesSerial interfaces

1 x RS-232/485 serial interfaceSerial interface

2 x 10/100Base-TX RJ-45 interfacesEthernet interfaces

4 x USB 2.0 interfacesUSB

Table 4.1-5 Optional PCI extensions
ValueDescription

1 x 1 LON interfaceLON interface 1)

8 x RS-232/485 serial interfacesSerial interfaces 2)

2 x 10BASE-T/100BASE-TX/1000BASE-T RJ-45 interfacesEthernet interfaces 3)

1) Operating temperature 0° C - +70° C

2) Operating temperature 0° C - +55° C

3) Operating temperature 0° C - +55° C

Table 4.1-6 Inspection of mechanical structure
StandardDescription

According to IEC 60255-5, -6Markings and mechanical
structure

According to IEC 60529Degree of protection by
enclosure

According to IEC 60255-5Clearance and creepage dis-
tances

Table 4.1-7 Power supply and module tests
StandardDescription

According to IEC 60255-6Auxiliary voltage

According to IEC 60255-11Aux. voltage interruptions

According to IEC 60255-11 12%, f = 2 x fnRipple in auxiliary DC voltage

According to CE EN 61010Power consumption
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Table 4.1-8 Insulation tests
StandardDescription

According to IEC 60255-5 2 kV, 50 Hz for 1 minuteDielectric test

According to IEC 60255-5 5 kV, 1.2/50 μs, 0.5 JImpulse voltage test

According to IEC 60255-5 >100 MΩ, 500 VdcInsulation resistance

According to IEC 60255-27 <0.1 Ω.Protective bonding impedance

The EMC immunity test level meets the requirements listed below:

Table 4.1-9 Electromagnetic compatibility tests
StandardDescription

According to IEC 61000-4-18 and IEC 60255-22-1

• 2.5 kV
• 1.0 kV

1 MHz burst disturbance test

• Common mode
• Differential mode

According to IEC 61000-4-2, IEC 60255-22-2

• 6 kV
• 8 kV

Electrostatic discharge test

• Contact discharge
• Air discharge

According to IEC 61000-4-3 and IEC 60255-22-3

• 10 V/m (80% amp.mod.)
• f=80...1000 MHz
• 10 V/m (pulse mod.) f=900 MHz

Radio frequency field immunity

According to IEC 61000-4-4 and IEC 60255-22-4

• 2 kV
• 1 kV

Fast transient

• Power supply
• RJ-45 port

According to IEC 61000-4-5 and IEC 60255-22-5

• 2 kV line-to-earth, 1 kV line-to-line

Surge immunity

• Power supply

According to IEC 61000-4-6 and IEC 60255-22-6

• 10 V (80% ampl. mod.)
• f= 150 kHz...80 MHz

Conducted radio frequency
disturbance

According to IEC 61000-4-8, 300 A/m, continuousPower frequency (50 Hz) mag-
netic field

According to IEC 61000-4-11

• 30% reduction for 10 ms
• 60% reduction for 100 ms
• 60% reduction for 1000 ms
• >95% reduction for 5000 ms

Voltage dips and short interrup-
tions

According to EN 55011, and IEC60255-25, class AEmission tests
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Table 4.1-10 Environmental conditions
ValueDescription

-25...+70ºC 1) 2)Operating temperature range

5...95% at +40ºCRelative humidity range, non-
condensing

-40...+70ºCStorage temperature

1) Without any option cards

2) With Ethernet option card: 0…+55°C, with Serial option card: 0…+55°C, with LON option card:
0…+70°C

Table 4.1-11 Environmental tests
StandardDescription

According to IEC 60068-2-2

Test values:

• 96 h at +55ºC
• 4 h at +70ºC

Dry heat test

According to IEC 60068-2-1

Test values:

• 96 h at -10ºC
• 4 h at -25ºC

Cold test

According to IEC 60068-2-30

Test values:

• 6 cycles (12+12h) at +25…55°C, humidity >93%

Damp heat test, cyclic

According to IEC 60068-2-48

Test values:

• 72 h at +70ºC
• 72 h at -40ºC

Storage test

Table 4.1-12 Mechanical tests
StandardDescription

According to IEC 60068-2-6 and IEC 60255-21-1

• f = 10...150 Hz, ± 0.035 mm, 10…58 Hz, 5 m/s2 58…150
Hz

• f = 10...150 Hz, ± 0.075 mm, 10…58 Hz, 10 m/s2 58…150
Hz

Vibration tests

• Vibration response test
• Vibration endurance test
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StandardDescription

According to IEC 60068-2-27 , IEC 60068-2-29 and IEC 60255-
21-2

• peak acceleration = 5 x gn, pulse duration = 11 ms, numbers
of pulses in each diretion = 3

• peak acceleration = 15 x gn, pulse duration = 11 ms, number
of pulses in each direction = 3

• peak acceleration = 10 x gn, pulse duration = 16 ms, number
of pulses in each direction = 1000

Shock and bump tests

• Shock response test
• Shock withstand test
• Bump test

According to IEC 60255-21-3 test method B

• 2 x gn in horizontal direction, 1 x gn in vertical direction

Seismic test

• biaxial multi-frequency
random seismic test

Table 4.1-13 EMC compliance
Complies with the EMC direct-
ive 2004/108/EC

EN 50263 (2000),

EN 60255-26 (2007),

EN 61000-6-2 (2005),

EN 61000-6-4 (2007)

Standards

Table 4.1-14 Product safety
Complies with the LV directive
2006/95/EC

EN 60255-27 (2005),

EN 60255-6 (1994)

Standards

Table 4.1-15 RoHS compliance
Complies with the RoHS directive 2002/95/EC

1) Microsoft® .NET Framework 2.0 is required for running SAB600. The software is automatically
installed during the installation of SAB600 if not already available on the PC.

Software properties4.2.

The software properties of COM600 are presented in the following tables.

Table 4.2-1 Communication protocols
Slave protocolMaster protocol

DNP3 LAN/WANDNP3 LAN/WAN

DNP3 serialDNP3 serial

IEC 60870-5-101IEC 61850-8-1
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Slave protocolMaster protocol

IEC 60870-5-104IEC 60870-5-101

External OPCIEC 60870-5-103

SPA routerIEC 60870-5-104

LON – LAG

MNS iS Connectivity

Modbus serial

Modbus TCP

SPA

Table 4.2-2 IEDs with connectivity packages supporting COM600
615 series IEDs

610 series relays

Feeder Protection Relay REF 610

Motor Protection Relay REM 610

Voltage Protection Relay REU 610

Feeder Protection Relay REX 521

SPAJ 140 series relays

Combined Overcurrent and Earth-fault Relay SPAJ 140 C

Combined Overcurrent and Earth-fault Relay SPAJ 141 C

Combined Overcurrent and Earth-fault Relay SPAJ 142 C

Combined Phase and Neutral Overcurrent Relay SPAJ 144 C

Stabilized Differential Relay SPAD 346 C

SACO 16D series units

Digital Annunciator Unit SACO 16D1

Digital Annunciator Unit SACO 16D3

Digital Annunciator Unit SACO 64D4

RE 500 series terminals

Feeder Terminal REF 541 / 543 / 545

Transformer Terminal RET 541/ 543 / 545

Motor and Generator Terminal REM 543 / 545

Feeder Terminal REF 542plus

Table 4.2-3 Hardware requirements for SAB600
RecommendedMinimumHardware

1 .5Gb1 GbFree hard disk space

30

1MRS756125Station Automation COM600COM600 3.3

User's Manual



Table 4.2-4 Supported operating systems 1)

Description

Microsoft XP Professional Edition, SP2 or later

1) Microsoft® .NET Framework 2.0 is required for running SAB600. The software is automatically
installed during the installation of SAB600 if not already available on the PC.

Mounting of COM600 computer4.3.

The COM600 computer is designed for mounting at a control panel.

To mount the COM600 computer to the wall-mount kit:
1. See Figure 4.3-1 for mounting instructions.
2. After the brackets have been installed, fasten four screws on each bracket.
3. After fastening the two brackets on the bottom lid of COM600 computer, the wall-

mount kit installation is finished.

COM600_mounting.jpg

Figure 4.3-1  Mounting diagram of the COM600 computer

For mechanical properties of the COM600 computer, see 4.1, Mechanical properties.

31

COM600 3.3Station Automation COM6001MRS756125

User's Manual



Setting up the COM2 port for RS-232/RS-4854.4.

By default the COM2 port is configured to RS-232 mode. The mode of the port (RS-
232/RS-485) can be changed via the BIOS setup of the computer.

COM2 port in RS-485 mode can only be used with Modbus
protocol. For more information on configuration settings, see
Modbus Master User's Manual.

To change the mode of the port:
1. Connect a local keyboard and display to the COM600 computer.
2. Restart the computer and press the Del key during restart to access the BIOS setup.
3. Select Integrated Peripherals from the main SETUP menu. Use the cursor keys

for moving and enter key for selection.
4. Select SuperIO Device from the next menu.
5. On the SuperIO Device configuration page, go to the COM2 Select parameter

and press ENTER. Now you can choose between RS-232 and RS-485.
6. Press the F10 key to save the changes and exit the BIOS setup.

Pinout of COM2 port when RS-485 mode is used:

DB9 connector:
1. TX-/RX-
2. N/A
3. TX+/RX+
4. N/A
5. GND
6. N/A
7. N/A
8. N/A
9. N/A
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Installation5.

About this section5.1.

This section describes the installation and uninstallation of SAB600, the installation of
the touch screen, and modifying and setting up of the COM600 computer. For more
detailed instructions on installation of the gateway components, refer to the 1.8, Related
documents.

Requirements for SAB6005.2.

The hardware requirements for SAB600 and supported operating systems are listed in
4.2, Software properties.

Installing SAB6005.3.

The SAB600 installation CD includes both SAB600 software and CoDeSys V3.2 SP2
software. In the installation wizard you can select, which software you want to install
or select both. For installation of CoDeSYs V3.2 SP2 software, see Installing CoDeSys
V3.2 SP2.

To install SAB600:

1. Close all open programs and insert the SAB600 installation CD to the CD-ROM
drive of your PC.

2. The installation program should start automatically. If the installation does not start,
open the program by browsing to the CD drive, and start COM_600.exe. The
installation wizard includes the options to install both the SAB600 software and
CoDeSys V3.2 SP2 software. If you want to install both, select both. CoDeSYs is
not installed by default.

3. Wait for the Wise Installation Wizard to extract the installation files to your PC.
4. The SAB600 installation program opens. Click Next.

At any stage of the installation, you can return to the previous window by clicking
Back, or exit the Installation Wizard by clicking  Cancel.

5. Read the License Agreement, then check the option I accept the license agreement
and click Next to continue the installation.
If you check the option I do not accept the license agreement, the Next button is
not available and you cannot continue the installation.

6. Select the folder where you want to install SAB600.
• To select the default folder shown at the bottom of the window, click Next.
• To select another folder, click Browse, select a new the folder, and click Next.

The default installation folder is C:\Program Files\ABB\COM600.
7. Select the desired installation type.
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• Typical: This option is recommended for most users.
• Complete: All SAB600 features are installed.
• Custom: Use this option to choose which SAB600 features you want to be

installed.
8. Click Next to start the installation.

You can follow the progress of the installation in a window that also shows the dir-
ectory path where the files are copied. At this point, you can still cancel the install-
ation by clicking Cancel.

9. A window opens showing that SAB600 has been successfully installed. Close the
window and finish the installation by clicking Finish.

10. The installation wizard will next install the Microsoft SQL Server, if it is not already
installed on your PC.

11. Restart your computer.

Start SAB600 by selecting Start > Programs > ABB > Station Automation Builder
600 > SAB600 from the Windows task bar.

Installing CoDeSys V3.2 SP2

The SAB600 installation CD includes also the CoDeSys V3.2 SP2 software. In the
installation wizard you can select, which software you want to install or select both.

1. Close all open programs and insert the SAB600 installation CD to the CD-ROM
drive of your PC.

2. The installation wizard includes the options to install both the SAB600 software
and CoDeSys V3.2 SP2 software. To install CoDeSys, select it and continue with
the installation by clicking Next.
The installation program should start automatically. If the installation does not start,
open the program by browsing to the CD drive, and start setup.exe.

3. Continue with the installation by clicking Next on every page of the wizard.
4. When the installation wizard asks for the folder where to install CoDeSys, select

C:\Program Files\3S CoDeSys.
5. It is recommended to install all the features listed on the opening page.
6. Continue the installation and when completed, click Finish.

Updating SAB6005.4.

If you have replaced an old COM600 with newer version, update your project that contains
that Gateway object. The project is updated by a conversion wizard. The conversion can
be activated in two ways after you have installed the latest SAB600 software.

Converting a project
1. Open the old project in the new SAB600. The conversion wizard is launched auto-

matically. Follow the wizard instructions.
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2. If the conversion wizard was canceled, you can run the conversion by right-clicking
on the Gateway object and selecting Convert project. Follow the wizard instructions.

3. Check the Gateway object properties to see if the COM600 version is the latest
version to confirm the conversion.

You can use the new SAB600 software with old COM600
versions. In this case, do not upgrade the Gateway object. The
project conversion wizard is automatically started when the
old project is opened. Simply cancel the wizard.

Setting up the COM600 computer5.5.

Accessing the COM600 computer5.5.1.

Local and Remote LAN ports

The COM600 computer has by default two LAN ports, a local (LAN 1) and a remote
port (LAN 2). See Figure 4.1-1. The local port is used for local connection in a secure
network within the substation, for example for engineering and process communication
with the IEDs. The local port has no firewall configured and it allows complete access
to the COM600 computer. The remote port is used for communication outside the sub-
station. It has a firewall pre-configured to allow communication only with web clients
and remote communication using protocols for example IEC 870-5-104 and DNP 3.0
LAN/WAN.

Table 5.5.1-1 shows the default IP addresses for the LAN ports.

Table 5.5.1-1 Default IP addresses for the LAN ports
IP AddressMaskGatewayLAN Port

Local Area Con-
nection (Local)

192.168.2.11255.255.255.0Not definedLAN 1

Local Area Con-
nection (Remote)

10.0.0.11255.255.255.0Not definedLAN 2

Some tasks, for example changing the IP addresses or adding users, require access directly
to the COM600 computer either locally or via the remote desktop software.

Accessing the COM600 computer:
• Locally by connecting a USB keyboard, a USB mouse, and a display to the computer.
• Remotely with the remote desktop program via LAN. By default the security settings

allow the remote desktop connection only via the interface reserved for the local
use.
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Regional settings

The default regional setting is English (United States).

Remote desktop

You can use the COM600 computer as a local console from an engineering computer
with remote desktop.

The COM600 computer can be restarted remotely by running restart.bat command from
the root of C drive.

Built-in user accounts

Two user accounts are predefined in the COM600 computer:
• Username: Administrator
• Password: pwd2004

This account is disabled by default for security reasons. If the
COM600 password is lost, you can enable the account tempor-
arily during the configuration phase to enable access to the
COM600 computer. It is recommended that you disable the
Administrator account later when the COM600 computer is
connected to the actual network.

• Username: COM600
• Password: aEc2006rs

This is the main account of the COM600 computer. It is used for configuration purposes.
Processes of the COM600 computer are run under this account.

Connecting configuration computer with SAB600 to COM600 computer

1. Configure the network settings of the configuration computer and the COM600
computer to allow them to communicate with each other. This is done by configuring
the IP addresses of the computers into the same subnetwork. Configure (or disable)
the possible firewall in the configuration computer to pass DCOM.

2. Connect either a crossover LAN cable between the computers or connect both
computers to a network switch. Use the LAN port used for local use in COM600
computer.

3. Create a COM600 user account with administrator rights to the configuration com-
puter. The password must be the same as in the COM600 computer.

4. Log in to the configuration computer as a COM600 user and launch SAB600.
5. Create a project and add the Gateway object to the communication structure.
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6. Type the IP address of the COM600 computer LAN port used for configuration to
the IP address property of the Gateway object.

7. Right-click the Gateway object and select Management. Verify that the communic-
ation with the COM600 computer is working properly. The first time you open the
management tool, you are required to change the COM600 user password. Click
Change password to change the password both in the COM600 computer and in
the configuration computer.
Close SAB600 and log in to windows to activate the new password.

The COM600 user password must always be changed as
described above to ensure that the password is changed
correctly for each component in the COM600 computer.

If you lose the password you cannot access the COM600
computer anymore either locally or remotely.

If you want to run SAB600 using a different user account than COM600 in the configur-
ation computer, do the following. If you use the COM600 user, you can skip the phases
below.

To run SAB600 using a different user account than COM600 in the configuration com-
puter:
1. Add the COM600 user to the configuration computer as described above.
2. Add the new configuration user to COM600 computer with administrator rights and

with the same password as in the configuration computer.
3. Configure the DCOM permissions for the new user in the COM600 computer as

described below.

DCOM settings are used to define permissions to use the COM600 computer.

To start the DCOM configuration:
1. Select Start > Settings > Control Panel > Administrator Tools > Component

Services or run the command dcomcnfg. The Component Services dialog opens.
2. Browse to My Computer and right-click the My Computer icon. Select Properties

from the shortcut menu.
3. Select Default COM Security tab from the My Computer Properties dialog.
4. Created user account must be added to both access permissions and launch permis-

sions.

To add permission:
1. Click Edit Default. The permission dialog opens.
2. Select the user you want to give a permission to use the COM600 computer.
3. Click Add and then OK.
4. Mark the check boxes for local and remote access, launch, and activation.
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After changing the settings restart both computers to activate the changes.

Uninstalling SAB6005.6.

To uninstall SAB600:

1. Open the Add or Remove Programs dialog by selecting Start > Settings > Control
Panel > Add or Remove Programs in the Windows task bar.

2. Select SAB600 and click Remove.

The uninstallation only removes SAB600 so that you can
install a new version and update the software. It does not
remove the Microsoft SQL Server and .Net Framework.
Removing these programs may infect the functionality of other
ABB applications installed on your PC.

Uninstalling CoDeSys v3.2 SP2

1. To open the Add or Remove Programs dialog, select Start > Settings > Control
Panel > Add or Remove Programs in the Windows task bar.

2. Select CoDeSys and click Remove.

Turning off COM600 computer5.7.

If a local display, keyboard, and mouse are connected to the COM600 computer:
1. If COM600 browser is used, login as a user that has administrator privileges to the

COM600 HMI.
2. Press CTRL+ALT+DEL and choose Shutdown from the dialog.
3. Wait until the following message appears in the display:It is now safe to turn off

your computer.
4. Press and hold the front panel power button for a few seconds until the SYS led on

the front panel turns off.

If the remote desktop session is active:
1. Run the shutdown.bat located in the C:\ of the COM600 computer.
2. Wait for about 30 s. Then keep the front panel power button pressed for a few

seconds until the SYS led on the front panel turns off.

If no desktop is available, keep the front panel power button pressed for a few seconds
until the SYS led on the front panel turns off.

To turn on the COM600 computer, press the power button briefly.
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Configuration6.

Opening a project in Station Automation Builder 6006.1.

This section describes the configuration tasks common to all OPC servers, and gives an
overview of the configuration tasks related to OPC clients.

All the possible configuration scenarios are not included in
this manual. Refer to the corresponding user’s manuals listed
in 1.8, Related documents for more detailed instructions.

Configuration and maintenance6.2.

SAB600 is used to configure and maintain COM600. Communication networks are
described in the Communication structure of the Project Explorer window. The structure
is built using OPC server/client, communication channel/subnetwork, and device objects.
These objects have communication properties that can be accessed via the Object Prop-
erties window. The properties define for example the communication port, bit rate, timing
parameters, unit addresses, and so on .

The substation structure of SAB600 is used to configure the HMI functions of the
COM600 products. The substation structure presents the functional view of the substation.
It includes substation, voltage level, bay, busbar, and conducting equipment objects.

The Single line diagram is a graphical presentation of the process objects in the substation.
The Single line diagram can be edited on different levels. The bay layout can be con-
figured by opening the SLD Editor from a bay object. When the SLD Editor is opened
from a voltage level object, it is possible to assign the positions of the bays within a
voltage level. The position of the voltage levels in the complete substation single line
diagram is done by opening the SLD editor from the substation object.

Substation objects are linked to communication structure objects by using the Data
Connection tool. For example, the circuit breaker object in the substation structure is
linked to the CSWI logical node in the communication structure. The link between the
structures is also used on the event list, to present the events using the names according
the substation structure.

Process data accessible on the devices is modeled according to the IEC 61850 standard.
In the communication structure this is seen as logical devices (LD), logical nodes (LN)
and data objects (DO). It is possible to insert an empty device into the structure and then
manually add and configure LD, LN, and DO objects. It is also possible to use pre-con-
figured object types of the devices, which have the objects defined and configured to
add efficiency. The device configuration can also be imported from an IED SCL
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description. Data objects include configuration properties, that contain cross-referencing
information between protocol and the OPC/IEC 61850.

Process data is connected to a Gateway client using a Cross-References function available
in the client IED object. Data objects that are transferred to the client are dragged from
the servers on the structure to the function tool. Cross-referencing information is filled
in the function window. The Cross-References function supports import and export with
Microsoft Excel.

When the structure is complete and all the objects have been set up properly the config-
uration is downloaded to COM600 using the Gateway Management function available
on the Gateway object.

The Logic Processor function is programmed with a separate programming editor.

Configuration process6.3.

Overview of configuration process6.3.1.

Before you can start using COM600, build and configure the communication and substa-
tion structure of your project in SAB600.

Start SAB600 and open and name a project.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

A project can have only one COM600 configuration.

Figure 6.3.1-1 shows an example view of SAB600 including an object tree in the Com-
munication structure on the left and property window displaying the object properties
on the right.
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IECSAB600Main.bmp

Figure 6.3.1-1 Example view of SAB600

The configuration can be divided into three tasks:

1. Building the object tree and configuring the object properties for OPC servers
(process communication).

2. Building the substation object tree and configuring the object properties for HMI
functions.

3. Activating COM600 with a new configuration.

First, build an object tree by adding objects to the object tree. For more information refer
to the respective user’s manual listed in 1.8, Related documents. Connectivity packages
for certain protection and control products usually contain preconfigurations and tools
to facilitate the building of the object tree.

Building and configuring object structures6.3.2.

OPC servers6.3.2.1.

Start the configuration work from the server objects. Before an OPC client can be taken
into use, configure an OPC server for the process communication.

41

COM600 3.3Station Automation COM6001MRS756125

User's Manual



The object tree is built in the communication tab of SAB600. There are several possible
ways to build an object tree. One of them is to build the object tree by adding objects in
logical order starting from the OPC server object. You can either use basic or pre-defined
objects. Using basic objects means that you have to configure the objects manually. If
objects are pre-defined, they are preliminary configured and all the necessary child
objects are automatically added.

Add the objects in the following order:
1. OPC server object
2. Channel/Subnetwork object depending on protocol
3. Device object
4. Logical device object(s)
5. Logical node object(s)
6. Data objects.

If you want to connect events or scales to data objects or
device connection status event classes to device objects at this
point, make sure that you have already created and configured
the event and scale objects.

For more detailed information on adding objects to the object tree, refer to the appropriate
protocol manual (see 1.8, Related documents).

Substation structure for HMI6.3.2.2.

Configuring the substation is the main task in configuring HMI functionality. If connectiv-
ity packages or IED SCL description files with substation structure information are used,
most of the substation structure can be built automatically when the IEDs are added to
the communication structure. If no substation structure information is available the
structure must be built manually.

Before you can create a substation structure, you have to create
a communication structure with OPC Server and communica-
tion channel objects, IEDs, Logical Devices, Logical Nodes
and Data objects.

For more detailed information, see COM600 HMI Configuration Manual.

OPC clients6.3.2.3.

The object tree is built in the communication structure. Before an OPC client can be
taken into use, confgure an OPC server for the process communication.
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ClientComStruc.jpg

Figure 6.3.2.3-1  Example of OPC client communication structure

The OPC client object is added to the same hierarchy level as the OPC server, see Fig-
ure 6.3.2.3-1. Below the OPC client object, you can add only channel and device objects.
The data objects are linked using the Cross-References function from the servers to the
client and further to the NCC. The Cross-References function can be also used to con-
figure the parameters of the data objects.

Add the objects in the following order:
1. OPC client object
2. Channel/Subnetwork object depending on protocol
3. Device object.

Configuring object properties6.3.2.4.

After the objects have been added, configure the object properties.

To configure an object:
1. Select an object in the object tree of the Communication structure.
2. The object properties appear now in the Object Properties window, see Figure 6.3.2.4-

1. You can see the selected object on the left and the available properties on the
right.
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IECObjProp.jpg

Figure 6.3.2.4-1  Example of object properties

3. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down combo box, or
• entering a text string or a numerical value in a text field.

With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu.

To import a new configuration file:
1. Click Choose File.
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2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large
the import can take time. To import a configuration file for a different device, right-click
the device, select SCL Import again and repeat the steps.

For detailed information about the SCL Import function, see 6.3.2.5, SCL Import function.

SCL Import function6.3.2.5.

You can import the communication structure under a Gateway, OPC Server or OPC
Client, and IED object with configurations from an existing file. Using the SCL import
function to import the structure. If an OPC Server or client configuration file is used,
then the whole communication structure is imported. Configurations can be imported
for single IEDs by selecting an IED object.

The file extensions for the import files can be .icd, .cid, .scd or .xml.

To import a configuration file:
1. Right-click the OPC Server or IED and select SCL Import from the shortcut menu.
2. Click Select File.
3. Browse for a new configuration file from the opening dialog.
4. Select the file and click Open.
5. Select the device to import from the drop-down menu. You can preview the config-

uration from the Objects tab.
6. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time.

All options in the SCL Import function are not available for
all protocols.
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SCL_Import.bmp

Figure 6.3.2.5-1 Example of IEC 61850 OPC Server SCL Import

SCL Import options from the Gateway, OPC Server or OPC Client, and IED level are
presented in the following.

SCL Import from Gateway level

The Gateway level import creates configurations for OPC Servers and OPC Clients
according to the importable SCL file.

SCLImportGW.bmp

Figure 6.3.2.5-2 SCL Import from the Gateway level
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SCL Import from OPC Server level

The OPC Server level import creates configurations for the selected OPC Server
according to the importable SCL file.

SCLImportServer.bmp

Figure 6.3.2.5-3 SCL Import from the OPC Server level

Check RCBs for Client Identity: Imports IEDs from the given file where Report Control
Blocks client identity matches the selected OPC Server.

SCL Import from IED level

The IED level import creates configurations for the selected IED according to the
importable SCL file.
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SCLImportIED.bmp

Figure 6.3.2.5-4 SCL Import from the IED level

Description for the different options:

• Alarm and Event Template: Select one of the predefined templates for setting Alarm
and Event handling for the objects that the import operation affects. There are two
template options:
• General Phase Tripping: by selecting this template, protection functions are

configured to send general alarms and events, regardless on whichever phase
is activated. It depends on the device, whether phase-specific information is
provided.

• Single Phase Tripping: by selecting this template, protection functions are
configured to send phase A-, B-, or C-specific alarms and events, if the device
provides phase-specific information.
If you are familiar with the issue, you can also create your own template by
copy-pasting existing templates. Browse to the current SAB600 installation
directory and find the \bin\Tools\SCLImport directory underneath it. Copy the
phasetrippingmapping.xml file and paste it to the directory and give it a mean-
ingful name. Open the file with an XML editor. Enter the name of the new
template to the AETemplateName element. Add or modify mappings in the
LNClass and DO elements. Use the information in the file as a guide.

• Filter DOs that don’t belong to the DataSet: This option limits the amount of data
objects being imported. If a data object does not belong to any data set, it is not
imported. Some IEDs can provide huge amounts of data that is not reported, that is,
not updated in COM600 HMI. Performance can be enhanced by checking this option.

• Overwrite existing descriptions: This option overwrites all existing descriptions on
objects affected by the import operation. Check this option only if you know that
the importable file contains better descriptions than your current configuration.
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• Do not import substation information: This option does not update the substation
structure. It can be used if you only must update the communication configuration.

• Import substation information from a separate template: This option allows you to
select a template that provides the substation configuration. It is useful, if there are
several identical configurations and you have created a good template for the sub-
station information.

These options are not available for OPC Client level or OPC
Client IED level imports.

System Consistency Check6.3.2.6.

System Consistency Check is intended to be used with IEC 61850 protocol to check that
the IED configurations currently used in the COM600 project are consistent with the
compared IED configuration files. If inconsistencies are found, the COM600 project
configuration can be updated. According to the IEC61850 standard, IEDs can have two
configuration revisions: one for data model and one for reporting. Configuration revision
for data model is modeled on the LD0\LLN0\NamPlt\configRev object. It is the most
important indicator of the configuration revision. Additionally each Report Control block
has a confRev attribute that defines the revision of RCB and the DataSet of RCB. System
Consistency Check checks each LDs LLN0\NamPlt\configRev and confRev of each
RCB.

The GUI tool is divided into two tabs: one for giving overview on the project with con-
figuration consistency status of IEDs, and another for setting options for the update
procedure. Additionally, by clicking Details, a dialog on consistency differences is
shown.

Always store the configurations with the same name to the same location. When you
save the configuration with an IED or system tool to the same location with the same
name and launch SCC Consistency, the column is automatically updated according to
the configuration changes. If you have not saved the configurations as instructed, point
the tool to the correct location and file by using the Browse button. If the configuration
is inconsistent, click the Details button for more detailed information. Finally, an indi-
vidual configuration can be updated using the Update button. The Update All button
updates all inconsistent configurations.
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SCC GUI.bmp

Figure 6.3.2.6-1 System Consistency Check view

SCC Options.bmp

Figure 6.3.2.6-2 Options view

The Options view allows you to select same importing options that are available in the
SCL Import tool. It is recommended that same options are used with both functions.
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SCC details.bmp

Figure 6.3.2.6-3 Details view

The Details view shows added or deleted LDs and RCBs. Additionally, it shows the
modifications to the content of LD or RCB.

Cross-References function6.3.2.7.

Data objects are added differently for OPC clients than for the upper level objects. Drag
and drop the data objects you need from an OPC server to the slave. You also can select
an upper level (server, channel, and so on) object and drag and drop it into the Cross-
References function. As a result, all the data objects within the selected object appear
in the Cross-References function and can be connected to the slave OPC client.
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CrossReferencesFunction.jpg

Figure 6.3.2.7-1  Cross-References function

In the Cross-References function, you can use a filter file to leave out some of the data
objects to be connected to the Slave Device. Select the filter file from the drop-down
menu under Active Filter. If there are no filter files listed in the drop-down menu, you
can create your own filter file by clicking Modify Filter File.

You can also modify an existing filter file to meet your needs. The Cross-References
table allows you to view the data objects by type. Use the tabs in the upper part of the
table to do this. Under the General tab, you can see all the data objects and their property
values. Here you can sort the data objects by clicking the column heading (Object Name,
Description, 61850-Type, and so on).

There is a possibility to export the cross-references table to Microsoft Excel and to import
the table from Microsoft Excel. Clicking Apply connects the data objects to the Slave
Device. After that you can change the data object values either in the Object Properties
function or in the Cross-References function. For more detailed instructions on config-
uring the data object properties in the Cross-References function, refer to the slave pro-
tocol user’s manuals listed in 1.8, Related documents.

Configuration of Station/Remote switch6.3.3.

Each IED and logical device in the OPC Server has a configuration parameter defining
the OPC node path for the S/R switch that is used for that IED/logical device. If a logical
device does not have an S/R switch path configured, the path defined in the IED is used
instead. At run-time, the S/R path of a logical device can be read from the OPC Server;
the LD S/R switch path is located in the LD node. The OPC server that has the S/R switch
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position information must have at least one signal mapped to the OPC client using this
information.

The S/R switch OPC path points to an OPC node modeled according to one of the sup-
ported IEC 61850 data classes. The stVal OPC item of the S/R object presents the state
of the S/R switch, 1 = station and 0 = remote. If the stVal item has the vartype VT_BOOL,
VARIANT_TRUE is interpreted as 1 and VARIANT_FALSE as 0.

Several IEDs/LDs can share the same S/R switch OPC path, or each IED/LD can have
an own S/R switch OPC path. The OPC node pointed by the path can be located in an
OPC server providing the S/R information from a physical switch or from a simulated
software switch.

The web HMI is considered to be local or remote based on the IP-address of the web
client. The gateway object has a configuration property which defines the addresses that
are handled as local. It can be either a single IP address or using wild cards a range of
IP addresses.

Event definitions6.3.4.

Creating event definitions6.3.4.1.

To create event classes:
1. Right-click the Events group in SAB600, see Figure 6.3.4.1-1.
2. Select  New -> Event classes.
3. Select the event class you want to add.
4. The new event class appears in the Process Definitions below the selected event

group. Enter a unique name for the event class by right-clicking it and selecting
Rename. The new event class can be configured and connected to a data object.
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creating_events.jpg

Figure 6.3.4.1-1 An example of creating event classes

Configuring event definitions6.3.4.2.

You can configure event definitions in SAB600. Event definitions specify the type of
events that are created for HMI event and alarm lists. You can specify whether an event
appears only on the event list, on both event and alarm lists, or whether it is displayed
at all. You can also add event texts for the events and specify whether alarms must be
acknowledged by the user.

Event definitions are linked to data objects by configuring the event properties available
for data objects. When importing IED configurations from connectivity packages or IED
SCL description files, event definitions are linked to data objects by default. For example
switch position data object CSWIx.Pos is linked by default to switch position event
definition. The default linking rules are specified in a DOParamsDefaults.xml file located
in the \Program files\ABB\COM600\bin\Tools\SCLImport in the computer where SAB600
is installed.

To configure event definitions:
1. Select the event you want to configure in the object tree.
2. The object properties appear now in the Object Properties window, see Figure 6.3.4.2-

1.
3. You can assign the event with parameter values.
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EventDefObjProp.jpg

Figure 6.3.4.2-1 An example of object properties of events

Configuring Alarm groups6.3.5.

Alarms can be grouped using the Group Alarm Configurator tool.

To create an alarm group:

1. Create virtual Application OPC server.
2. Create Virtual Subnetwork.
3. Create Virtual IED.
4. Create Virtual LD.
5. Create LN.
6. Create GroupAlarm SPS object

If you are going to create several Group Alarm objects, rename each object with a
unique name within LN.

7. Open Group Alarm Configurator.
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Drag and drop the data objects, which shall belong to the alarm group to Group Alarm
Configurator tool. You can use data objects from any of the OPC servers of COM600.
The data objects of following types can be used as a member of alarm group: ACD,
ACT, SPS, SPC, DPS, DPC, INS, or INC. When the objects are inserted to the tool, they
have by default the alarming states configured according the event definition linked to
the object. If no event definition is linked to an object, it does not have any of the states
as alarming. Alarming states can be manually specified in the tool by checking the cor-
responding check box of the state.

When the objects have been added and the alarm states are configured, accept the con-
figuration by clicking apply.

The logic of the alarm group is configured with the Group Alarm Logic Property of the
object. There are three choices:

• AND
Alarm group is active if all signals belonging to the alarm group are active. Signal
changes which does not change alarm group state or quality does not cause an update
in the alarm group object.

• Dynamic OR
Group alarm is active if any of the signals belonging to the alarm group is active.
Any signal state change causes an update of the alarm group object even if the state
or quality of the alarm group does not change.

• Static OR
Group alarm is active if any of the signals belonging to the alarm group is active.
Signal changes, which do not change the alarm group state or quality, does not cause
an update in the alarm group object.

The handling of the source signal quality is configured with the Signal Handling property.
There are three choices:

• Group Quality Follows Signal Quality
Group alarm is calculated using only the signals with good/known quality. The
group alarm has the quality of the signal with the worst quality in the group.

• Unknown Signal StatesTreated As Alarming
If the alarm group contains any signal with bad or unknown quality then the alarm
group is active. The quality of the group alarm is always good.

• Unknown Signal States Ignored
Group alarm is calculated using only the signals with good/known quality. If no
signals have good/known quality then the group alarm is inactive. The quality of
the group alarm is always good.

Group Alarm object is an SPS data object, which has value true when the group alarm
is active and value false when it is inactive. The object can be further used in the COM600
HMI or it can be forwarded to external systems using the slave protocol cross-reference
tool.
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Using scales6.3.6.

General about using scales6.3.6.1.

You have to use scaling if a measurement value provided by the device is not as such
suitable for the applications, and you need to change the provided value to another.

With a scale you can convert one value to another by using a scaling algorithm. OPC
servers support two types of scales: Stepwise Linear and Look-up Table. The Stepwise
Linear scale multiplies the value to be converted with a scale factor and adds an offset
value to the result, and the Look-up Table scale uses a look-up table to find the required
value.

Before you can connect a scale to a data object, add and con-
figure the scale in SAB600. Add and configure the scales
before adding and configuring any other objects.

Creating scales6.3.6.2.

To create scales:
1. Right-click Scale Definitions in SAB600, see Figure 6.3.6.2-1.
2. Select  New -> Scales.
3. Select the scale to add (a Look-up Table or Stepwise Linear).
4. The new scale appears in the Scale Definitions. Enter a unique name for the scale

by right-clicking it and selecting Rename. It can be configured and connected to a
data object.
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creating_scales.jpg

Figure 6.3.6.2-1 Creating scales

Configuring scales6.3.6.3.

To configure scales:
1. Select the scale you want to configure in the object tree.
2. The object properties appear now in the Object Properties window, see Figure 6.3.4.2-

1.
3. You can assign the scale with parameter values.
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ScaleDefObjProp.jpg

Figure 6.3.6.3-1 Object properties of the scales

Table 6.3.6.3-1 Scales
DescriptionValue or value range/ DefaultProperty/Para-

meter

Basic

Look-up Table and
Stepwise Linear

Value to be scaled-01 In Value

Scaled value-01 Out Value

Value to be scaled-02 In Value

Scaled value-02 Out Value

Value to be scaled-03 In Value

Scaled value-03 Out Value

Value to be scaled-04 In Value
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DescriptionValue or value range/ DefaultProperty/Para-
meter

Scaled value-04 Out Value

Value to be scaled-05 In Value

Scaled value-05 Out Value

Value to be scaled-06 In Value

Scaled value-06 Out Value

Value to be scaled-07 In Value

Scaled value-07 Out Value

Value to be scaled-08 In Value

Scaled value-08 Out Value

Value to be scaled-09 In Value

Scaled value-09 Out Value

Value to be scaled-10 In Value

Scaled value-10 Out Value

After you have performed all the necessary configurations, see 7.1, Activating COM600
with new configurations.

Backing up and restoring6.4.

To back up the SAB600 project:
1. Select File > Open/Manage Project.
2. Select the project you want to back up.
3. Select Export Project on the left.
4. The File dialog opens. Select the location where to export the database.

To restore your backup:
1. Select File > Open/Manage Project.
2. Select Projects on my computer.
3. Select Import Project on the left.
4. The File dialog opens. Choose the exported database you want to import.

Retrieving previous configuration6.5.

An existing configuration can be downloaded from COM600 to SAB600 using the
Management tool under the Communication view.

To retrieve and existing configuration:
1. Right click the Gateway object in the Communication view.
2. Select Management.
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3. From Configuration control, click Retrieve COM600 Configuration.
4. In the file view, browse to the location of the required configuration file.
5. Click Open.

This functionality can only be used with an empty Gateway object of version 3.2 or
newer. For older versions of the Gateway object, or if there are server or client objects
under the Gateway object, the functionality is disabled.

SCL Export6.6.

Export the configuration files of the COM600 OPC Servers and Clients in SCL format
using the SCL Export function in the Gateway object. This function can be used to
transfer the configuration information to other systems and tools.

To export configuration files in SCL format:
1. Right-click the server object in the Communication tree and select SCD Export.
2. The SCD Export window opens.
3. Click Export and select the location where you want to save the SCL file. Click

OK.

Both the communication view and substation view configurations are exported.

To export just the communication view:
1. Right-click the Gateway object in the Communication tree and select SCL Export.
2. The SCL Export window opens. Select whether you want to export all configurations

or a certain OPC Server or Client configuration.
3. Click Export and select the location where you want to save the SCL file. Click

OK.

CID Export

Export the configuration files of IEDs in CID format.

To export configuration files in CID format:
1. Right-click the IED in the Communication tree and select CID Export.
2. A Windows Explorer window opens. Rename the file, if necessary, and browse to

the location where you want to save to file.
3. Click Save.

Both the communication view and substation view configurations are exported.
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Configuring external watchdog for COM6006.7.

The communication to the IED used as a watchdog is configured as with any IEDs using
SAB600. The IED is configured with SPC or INC type of data object to which the cyclical
command is sent.

To configure COM600 to use an IED as an external watchdog:

1. Right-click on the Gateway object and select Properties.
2. Enter the Command OPC Item Path in the following format:

Node#ProgID For OPC Server#Channel Name\IED Name\Logical Device
Name\Logical Node Name\Data Object Name\Data Attribute Name

Other properties are set according to the preference of the user, but they can be left as
they are by default. These are:

• Command Write Value
The value that is written to the command OPC item. The default value is 1.

• Command Write Interval
How often the command is sent. The default value is 5 seconds.

Installing and configuring Duo Driver6.8.

Duo Driver is available when the optional LAN card is installed in COM600.

Before the installation, it is recommended to rename Intel(R) PRO/1000 MT Dual Port
Server Adapter ports to DUO Line A and DUO Line B. Open the Network Connections
dialog and select the Properties for the Duo Driver devices. Configure static IP address
on DUO Line A and disable the TCP/IP stack on DUO Line B.

To install the Duo Driver:

1. Run the Duo Driver Setup Wizard file, C:\DuoDriver\setup.exe (in the
COM600 computer)

2. Click Next.
3. In the Select Installation Folder dialog, select Everyone.

Click Next.
4. Before the installation is completed, a notice stating that the software has not passed

Windows Logo testing is displayed. This is normal.
Click Continue Anyway.

5. During the installation process, the file virtualnic.sys is required. Browse to the
location C:\Program Files\DuoDriver.
Click OK.

6. When the installation is completed, the following message is displayed:
Driver not yet ready! All parameters are ignored until initial Pairing is done.
Click OK.
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After the installation, the Duo Driver Management and Supervision Interface will
open.

Configure the following:

1. Set Line A/Primary to Duo Line A and Line B/Secondary to Duo Line B
Click Apply.
The MAC address for each line is shown.

2. Enter a valid MAC address for MAC Address A or leave as default.
Click Apply.

3. For MAC Address B, enter the same value as used for MAC Address A.
Click Apply.

4. To complete the configuration, click OK.

The Duo Driver installation is now complete.

Installing Intel Teaming feature to COM6006.9.

The Teaming feature is available only if a LAN optional card has been installed in
COM600.

Teaming Features include Failover protection, increased bandwidth through aggregation,
and balancing of traffic among team members. Teaming Modes are AFT, SFT, ALB,
RLB, and EtherChannel*/3ad (LA/FEC/GEC/3ad). However, only Failover protection
using SFT is supported by ABB. SFT uses two (total) adapters connected to two devices
(that is, switches) to provide a fault tolerant network connection if the first adapter, its
cabling or the device (switch) fail. This is determined by a link failure.

To use the SFT connect Intel(R) PRO/1000 MT Dual Port Server Adapter network ports
to two devices (that is, switches). Spanning tree protocol must be switched on in the
devices (switches). Do not put clients on the link partner switches, as they do not pass
to the partner switch at fail.

To install the Intel(R) PRO/1000 MT Dual Port Server Adapter:
1. Open Control Panel.
2. Double-click System.
3. Click the Hardware tab and select Device Manager.
4. Expand Network adapters and double-click Intel(R) PRO/1000 MT Dual Port

Server Adapter.
There are two adapters with the same name, select one of them.

5. The Properties windows appear. Select the Teaming tab.
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Intel_Pro_Port_Server_Adapter.JPG

Figure 6.9-1 Opening the Teaming tab

6. Select Team with other adapters and click New Team….
7. Specify a name for the team and click Next.

New_Team_Wizard.JPG

Figure 6.9-2 New Team Wizard

8. Select both Intel(R) PRO/1000 MT Dual Port Server Adapters and click Next.
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9. Select Switch Fault Tolerance to a team mode and click Next.

Switch_Fault_Tolerance.JPG

Figure 6.9-3 Switch Fault Tolerance selection

10. Click Finish to start installation
11. During the installation setup asks for location of the iansmsg.dll file. It can be found

under C:\Program Files\Intel\Ans. Browse the location and click OK.

Files_Needed_Dialog.JPG

Figure 6.9-4 Files Needed dialog

12. Configure the Team. Click OK to close the Properties dialogs.

The Team is now made. One virtual network adapter (named “Local Area Connection
3”) appears into Control Panel > Network connections. Configure the IP address for
this adapter.

For more information about Intel Teaming feature, see Intel documentation.
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Configuring Data historian6.10.

Preparing COM600 for Data Historian6.10.1.

The following operations must be performed in the COM600 computer as the adminis-
trator user to prepare COM600 for Data Historian feature.

Setting the time zone of RTDB

The time zone of the RTDB is by default GMT and it must be set before taking the Data
Historian feature into use.

To set the time zone:
1. Select Start -> All Programs -> Data Historian -> Change Time Zone.
2. The following file browser dialog opens.

rtdbtimezone.bmp

Figure 6.10.1-1 Time Zone Definition

3. Select the time zone from the list and click Open.
4. Reboot the computer so that the service processes notice the new setting.

The setting is stored in a system environment variable.
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Preconfiguring Vtrin Client Environment

To change the default layout and views for Vtrin users, log in to Vtrin with the COM600
HMI administrator user name and password. The administrator user has full access to
Vtrin functions and objects.

Enabling Vtrin into use

To be able to use the Data Historian Vtrin tool, Vtrin must be installed on the client
computer. When clicking the Data Historian menu item in HMI for the first time, the
Vtrin client is installed.

HMI_Data_Historian_menu.bmp

Figure 6.10.1-2 Data Historian menu item shown in Web HMI

To enable the Vtrin installation to client computers, specify the IP address of the COM600
computer, which is used for the Vtrin connections.

1. From the COM600 computer start menu, select Start -> All Programs -> Data
Historian -> Change Vtrin IP Address.
The program prompts you for the IP address of the COM600 computer.

2. Enter the IP Address and press enter.

If the IP address of the COM600 computer is changed,
change the Vtrin IP Address again.
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Configuring Data Historian measurements and signals6.10.2.

In Data historian configuration measurements and signals from devices are selected for
history information. The trends can then be investigated in COM600 HMI. The function
includes several configuration parameters.

To configure Data historian:
1. Right-click the Gateway object and select Data Historian Configuration from the

shortcut menu.

DataHistorianConfiguration.bmp

Figure 6.10.2-1 Opening Data Historian Configuration tool

2. The Trend Configuration dialog opens.
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DataHistorianConfigurationTool.bmp

Figure 6.10.2-2 Data Historian Configuration tool

3. Drag and drop data objects to the Data Historian Configuration tool, where they are
displayed as rows. Some of the rows are write-protected. You can modify the values
in the Cycle, Minimum Value, Maximum Value, Description, Unit, and History
Levels columns, although the values are set according to the values defined for the
data object.

4. You can modify the editable values. Check the values for the History Levels column
from COM600 Data Historian Operator's Manual.

5. Select the desired signals for the configuration with the checkboxes in the Selected
column. With Select and Unselect you can select or unselect multiple rows at the
same time.

6. Save the configuration in the SAB600 project by clicking Apply.

The configuration is activated to COM600 as described in 7.1, Activating COM600 with
new configurations.
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Operation7.

Activating COM600 with new configurations7.1.

After the configurable objects in the object tree have been created, the configuration
must be transferred to the COM600 computer. This is done by using the Management
function.

To activate the COM600 configuration
1. Right-click the Gateway object in SAB600 and select Management.
2. The Management dialog opens.

Management.jpg

Figure 7.1-1  Management function

• To copy the configurations of all servers and clients to the COM600 computer,
click Update configuration.

• To transfer only the changed configurations and to restart only the changed
server or client with new configurations, click Update & reload configuration.

• To force a complete configuration reset of COM600, mark the Reset check box
before updating the configuration. All instances of OPC servers and clients are
recreated in COM600. This normally must be done only if the same COM600
computer is configured using several engineering computers with different
projects, for example during training or testing.

License handling7.2.

The COM600 Management tool displays the license information for COM600 under
License Information. The license and the protocols it supports have been predefined
before the COM600 computer has been handed over by ABB.

70

1MRS756125Station Automation COM600COM600 3.3

User's Manual



The following information is shown in the window:
• owner of the license
• product revision
• protocols supported by the license.
• number of servers supported by the license.
• number of clients supported by the license.
• if WebHMI is enabled.

To update the license with a new set of protocols, order a new license from ABB and
update it to COM600 with SAB600.

To update the license:
1. Open the Management tool from the Gateway object in SAB600.
2. Click Update License.
3. Browse for the new license file and click Open.

The license is COM600 specific and the COM600 computer verifies the compatibility
of the license. Also the servers and clients verify the license.

Diagnostics7.3.

General about diagnostics7.3.1.

SAB600 provides comprehensive functions for diagnosing the operation of the Gateway.
This includes communication diagnostics with monitoring the communication channel,
diagnostic counters, and IED-specific communication status and diagnostic counters. It
is also possible to monitor and control process data and follow the data flow on the
Gateway using diagnostic functions of SAB600. Figure 7.3.1-1 displays a sample view
of a diagnostic counter dialog. An example of an event log file is displayed in Figure 7.3.1-
2.
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SPAChnlDiag.jpg

Figure 7.3.1-1 An example of a SPA channel diagnostic counter dialog

EventDial.jpg

Figure 7.3.1-2 An example of a SPA event log file

Data object diagnostics7.3.2.

You can monitor and control the data objects under the Gateway object tree with Data
object diagnostics.
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To monitor and control the data objects:
1. Right-click the Gateway object in SAB600.
2. Select Data object diagnostics from the shortcut menu, see Figure 7.3.2-1. The

Data object diagnostic dialog opens.
3. Drag and drop data objects from the object tree to the Data object diagnostics.

Or

1. Select a specific data object from the object tree.
2. Select Tools > Online diagnostics.

DataObjDiagnos.jpg

Figure 7.3.2-1 Data object diagnostics

To change the value of a data object attribute:
1. Select a specific attribute.
2. Write a new value to the text box under the Write value button.
3. Click Write value to change the value.

To filter the displayed data object:
1. Click Excluded items.
2. Notepad opens. Write to Notepad the data object types you want to exclude from

the Data object diagnostics view.
3. Save the file as a .txt file by selecting File > Save.

Diagnostic services of OPC servers and clients7.3.3.

You can control and monitor the server and client channel and device communication
in the communication structure of the Project Explorer. You can take channels/subnet-
works and devices into use or out of use via the respective diagnostics function. You
can also monitor the channel/subnetwork and device communication with the help of
various diagnostic counters, and check the device status information, see Figure 7.3.3-
1.
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LON_Clock_Master_Online_diagnostics.jpg

Figure 7.3.3-1 An example of LON Clock Master online diagnostics

For more detailed information and instructions on controlling and monitoring channel
and device communication, refer to the respective user’s manual for the client or server
(see 1.8, Related documents).

Signal diagnostics7.3.4.

OPC clients have a diagnostics function which makes it possible to monitor the flow of
process data changes and commands. Activate the function by marking the Diagnostic
Events Enabled check box, located in the Online diagnostics function of the
IEC101/IEC104 Device. When the diagnostics function is activated, the IEC101 OPC
Client Alarm & Event server generates events with information about data changes and
commands.
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IEC101AEClient.jpg

Figure 7.3.4-1 IEC101 Slave OPC Client Diagnostic AE client

Diagnostic Web Server7.3.5.

The Diagnostic Web Server of the Gateway provides an overall view of the communic-
ation status of the Gateway and the possibility to monitor the diagnostic counters of the
communication channels/subnetworks and IED communication. Figure 7.3.5-1 displays
the gateway objects in a tree view.

A red cross over the Gateway icon in the object tree indicates that there is a fault in the
communication structure. Expand the tree to view the hierarchy deeper and to identify
the device with a missing configuration or causing the error. The properties of a certain
object in the communication structure can be seen on the right when clicking the object
in the tree view.
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Webserver_a.jpg

Figure 7.3.5-1 An example of a web page from the Gateway diagnostic web server
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